
 

 

 

SESSION 2 
The Adventure Begins 
In this session, students begin creating their animated story. To start, they 

produce the title slide that contains a background, movie title, and director 

credit. Afterwards, they format the appearance of text on the slide to make it 

look eye-catching. Once the slide looks great, they insert a new blank slide to 

use as their “portal slide”. A background picture and video footage are added 

to the slide to show the character entering a strange new world. 

Assignment 5: Start Your Adventure 

Assignment 6: Make a Portal Slide 

Session 2 Extension Activity: How to Draw in PowerPoint 

 

  

Each TechnoKids project 
contains 6 sessions, with 
separate assignments. Although 
teaching time may vary, each 
assignment takes about 20 
minutes to complete. 

SAMPLE

TechnoKids Inc.
Typewritten Text
Learn more about TechnoMovie

http://www.technokids.com/Store/Elementary-School/TechnoLink/teach-web-design-to-kids.aspx
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Session 2: The Adventure Begins 

GETTING STARTED 

Overview 

In this session, students begin creating their animated story. To start, they produce the title slide 

that contains a background, movie title, and director credit. Afterwards, they format the 

appearance of text on the slide to make it look eye-catching. Once the slide looks great, they 

insert a new blank slide to use as their “portal slide”. A background picture and video footage 

are added to the slide to show the character entering a strange new world. 

 

Materials 

 PowerPoint 2013 

 PowerPoint 2013  Flashcards (Optional) 

o Home Tab 

o Insert Tab 

o Design Tab 

o Slide Show Tab 

o Quick Access Toolbar 

 Story planner created in Session 1 

 Video created in Session 1 

 

Teacher Preparation  

 Print the flashcards listed in the materials list for this session. (Optional) 

 

Teaching Strategy 

 

In this session, students make the first two slides of their movie. Explain scenario to students: 

 

In this session, you are going to create the first two slides of your 

movie. On the title slide, you will put the title of your movie and 

your name as the director of the movie. You can also choose a 

background design.  

 

The second slide is a portal slide. Here you will be transported 

magically into another world. The slide will have a background 

pattern and the video of you moving from this world to the next. 

 

Let’s get started! 

 

 

  

This section for teachers 
explains each assignment 
and gives helpful tips. 

SAMPLE
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Assignment 5 Start Your Adventure  

 

In this assignment, students learn to use PowerPoint to create their title slide of the movie. When 

choosing a background, encourage the students to browse all the types of options before 

making their choice. 
 

 

Assignment 6 Make a Portal Slide 

 

In this assignment, students select an image that provides the background design for their video. 

It can be any pattern that creates the feeling of a portal – a doorway or entrance to the 

magical world that the student has invented. 

 

Search Tips 

 

Students use the Online Pictures tool to search either Office.com or Bing Image Search. Try the 

following search terms to find images that convey the impression of a portal: 

 

 designs 

 patterns 

 shapes 

 circles 

 spiral 

 doors 

 portal 

 black hole 

 

Copyright Warning 

 

You may wish to use this as an opportunity to discuss copyright issues with students.  

 

When students search using the Online Pictures tool, search 

results from the Bing Image Search are flagged with a 

reminder that only licensed images are shown by default. 

Explain to students that the search results include only content 

whose creators have expressly given permission for public use.  

 

Should students need to click Show all web results  

in order to find an image for the portal, they could possibly be 

violating copyright, and license information should be checked before using such pictures.  

 

Click Close  to remove the yellow warning and view a larger window. 

 

Video Test 

 

Next, the video filmed in the previous session is inserted onto the portal slide and set to play 

automatically. Test this step before having the students complete the assignment. Video 

cameras and web cams save videos in a variety of file formats. Videos in the .mp4, .mov, and 

.qt formats can be played in PowerPoint if the Apple QuickTime player is installed. Go to 

www.apple.com to download the latest version of this free software, if necessary. 

 

Finally, students play the first two slides of the slide show to test the playing of the video. 

 

  

SAMPLE

http://www.apple.com/
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Lesson Plan 

Assignment 5 - Start Your Adventure 

 Open Microsoft PowerPoint. 

 Add the title and the name of the director. 

 Make the title and the director’s name look great by changing the font, size, style and 

color. 

 Add a background to the slide by applying a solid color, gradient fill, or texture. 

 Save the movie. 

 Close PowerPoint. 

 

Assignment 6 - Make a Portal Slide 

 Open a saved presentation. 

 Insert a new blank slide. 

 Search online to add a background picture. 

 Insert a video clip. 

 Place and resize the video clip. 

 Choose a video style. 

 Move between the slides. 

 View a show. 

 Save the movie and close PowerPoint. 

  The Lesson Plan lists 
individual steps in each 
assignment. 

SAMPLE
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete 

each task independently. 

 

Content Knowledge: 

 

 understand the meaning of a portal as a door or entrance to another world 

 select an image and a background related to the movie theme 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 save a file 

 open a saved file 

 name a file 

 

Multimedia 

 choose an appropriate slide layout 

 add text to a slide 

 format the font, size, style, and color of text 

 add and format a background to a slide 

 insert an image found online as a background for a slide 

 insert a video file 

 resize and position a video clip on a slide 

 choose a visual style for a video clip 

 view a slideshow 

 

Applied Technology 

 create a title slide in PowerPoint 

 create a slide of a character entering a magical world 

 

 

 

 

 

 

 
Each session includes a list 
of Learning Objectives.  
A checklist of all objectives 
in the project is provided in 
Session 7. SAMPLE
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Assignment 5: Start Your Adventure 
 

Create a title slide for your adventure movie. You will: 
 

 Add a slide background. 

 Add a title and your name to the slide. 

 Format the appearance of the text. 

 

Open PowerPoint 

 Open PowerPoint. 

 Click Blank Presentation. 

 
 

Add the Title and the Name of the Director 

 Click inside the title text box. Type the Name of Your Adventure Movie. 

 Click inside the subtitle box. Type Your Name as the director of the movie. 

 
 

Make the Title and Director’s Name Look Great 

 Triple click the mouse on the text inside the text box to select all of the text. 

 

Change the Font  

 On the Home tab, find the Font group. Click the arrow beside Font. 

 Click on a font in the list to apply it to the title. 

 

Change the Font Size  

 With the text still selected, click the Font Size arrow. 

 Click on a size in the list to apply it to the title.  

Illustrated step-by-step instructions 
make PowerPoint easy for beginners. 

SAMPLE
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Apply a Font Style  

 With the text still selected, choose a style. 

    

BOLD ITALIC UNDERLINE TEXT SHADOW 

 

 

Change the Font Color 

 With the text still selected, click the Font Color arrow. 

 Choose a color from the palette that looks good. 

 

 

Make the Words Look Great 

 Apply your knowledge to make the director’s name look great. 

 
 

 

Add a Background to the Slide 

 

 Click the Design tab. 

 Find the Customize group and click Format Background. 

 
  

For the background of your slide, you can choose one of the 

following: 
 

 a solid color 

 a gradient fill, which is a color that changes in shading 

 a texture or pattern 
 

Try all of them and then pick your favorite. 

The Format Background pane 

opens with background fill 

options 

For the paperless classroom, 
each assignment may be viewed 
as a digital file. 

SAMPLE
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Apply a Solid Color 

 Click Solid fill. 

 Click the drop-down arrow beside Color and click on a color or click More Colors… 

 

 To change the background, click on a color and click Close.   

 

 

Apply a Fill Effect: Gradient fill   

 Click Gradient fill.  

 Experiment with the choices: 

  

Preset gradients are a set of 

premade shading designs. 

Type allows you to choose a 

shape for the color gradient. 

Direction allows you to choose 

where the shading starts. 

If you cannot see any color in 

the background, change 

Transparency to 0%. 

To remove the background 

color, click Reset Background. 

Use the scroll bar to see 

all the gradient choices. 

Gradient stops lets you adjust 

the shading of the gradient. 

Close the Background pane. 

Students are challenged to 
explore tools. 

SAMPLE
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Apply a Fill Effect: Texture 

 Click Picture or texture fill.  

 Click the arrow beside Texture: and click on any pattern. 

 
 

 

 
 

 

 Choose the background suits your movie best. DO NOT CLICK Apply to All. 

 

 

Save the Movie 

 Click Save on the Quick Access Toolbar. 

 Go to your student folder. 

 

 Click Save. 

 

 

Close PowerPoint 

 Click Close on the PowerPoint window. 

Now it is time to pick the best background for your movie. Pick a 

color, gradient, or texture. Think about the color and design to make 

sure it fits the story that you are going to tell. 

Notice that the name of your movie is automatically 

the name of your file. You do not have to change it. SAMPLE
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Assignment 6: Make a Portal Slide 
 

 

 
 

 

Open a Saved Presentation 

 Open PowerPoint. 

 OPTION 1: Click the presentation in the Recent list. 

OPTION 2: Click Open Other Presentations. 

o Click Computer. 

o Click Browse. 

o Go to your student folder. 

o Double click the presentation. 

 

 

Insert a New Slide 

 On the Home tab, find the Slides group and click the arrow beside New Slide. 

 From the gallery of layout choices, click on Blank. 

  

You want the audience of your movie to watch as you are 

transported into another world. This will take place on the 

second slide of your movie. It is called the portal slide. A 

portal is a door or entrance to another place. Here you will 

be using the video that you made in Session 1. 

Tip: 

If you clicked on New Slide and a slide appeared with title and content boxes, you can 

still change the layout. Click on Slide Layout in the Slides group and choose Blank. 

Students are guided to 
create each slide of the 
movie. Each slide features 
new skills. SAMPLE
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Add a Background Picture 

 

 Click the Design tab, find the Customize group, and choose Format Background. 

 In the Format Background pane, select Picture or texture fill. 

  In the Insert picture from section, click Online. 

 
 

 In either search box, type a search term for the background image. Some ideas are: 

 designs  patterns  doors  spiral 

 circles  shapes  black hole  portal 

 

 

 Click Search. 

 The results are displayed. Scroll down to view the pictures. 

 

 

 

 

 

  

You are going to add a background to this slide but this 

time you will use a picture. The picture will be a background 

that helps give the idea of you being transported to 

another world. Look for a picture that gives the idea of 

movement, magic, a black hole, or maybe a time warp! 

SAMPLE
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 Click on the picture that you like. 

 Click Insert. 

 
 
 

 
 

Insert a Video Clip 

 Click the Insert tab, find the Media group and click the arrow beside Insert Video. 

 Pick Video on My PC. 

 Go to your student folder and click the file called video. Click Insert. 

 

 

Place and Resize the Video Clip 

 To move the video clip, click on the object until the cursor becomes a four way arrow, 

and drag it where you want it to be on the slide.  

 
 

 

 To resize the video clip, click on the object and drag a corner handle outwards to make 

the movie larger or inwards to make the movie smaller. 

Next, you are going to put the video you made 

onto this slide. Think about the impression you 

want to give the viewer. The movie should try to 

give the effect of a person travelling through a 

portal or door to another world. 

The image appears on 

the blank slide and fills 

the background. 

corner handles 

media controls 

When the mouse 

pointer becomes a 

four way arrow, drag 

the object. 

When the mouse 

pointer becomes a 

two way arrow, 

resize the object. 

In the second slide, a short 
video clip of the student 
is inserted to create the 
impression of a portal.  

SAMPLE
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Choose a Video Style 

 With the video clip still selected, click the Video Tools Format tab. 

 Find the Video Styles group and click the More arrow. 

 
 

 Hold the mouse pointer over each style option to see a Live Preview. 

 When you find a style you like, click on it to apply it to the video. 

 

 
 

 

  

Always use one of the four corner handles to resize the 

video. In this way, the proportions of the video will be 

preserved. 

 

If the side handles are used, the video will be stretched 

or skewed. People or objects will appear unnatural.  

 

Consider the background picture you chose. Adjust 

the video to suit the portal. In the next step, you can 

change the look of the video frame. 

More arrow 

SAMPLE
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Move between Slides 

 Click the first slide in the Slides Pane to go to Slide 1. 

 
 

 

View a Show 

 On the Quick Access Toolbar, click Start From Beginning. 

 Click the mouse to advance to the second slide. 

 Hold the mouse pointer over the video to make the media controls appear. 

 

 Click the Play arrow to play the video. 

 Click to advance the slide. 

 At the end of the show, click the mouse to exit. 

 

 

Save the Movie and Close PowerPoint 

 Click Save on the Quick Access Toolbar to save the changes to your movie. 

 Click Close. 

 

  

Volume control  Play arrow  

The media controls show when 

the mouse pointer rests over any 

part of the video. 

It's time to have a preview 

of the first two slides in your 

slide show so far.  

 

Move to the first slide to see 

the slide show. You will 

need to click the mouse to 

advance the slides and to 

make the video play. 

SAMPLE
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Challenge: You can make your own portal design by using 

a picture to create a unique tiled texture. Try it! 

 

1. Click Format Background and choose Picture or texture fill. 

 

2. In the Insert picture from section, select Online. 

 

3. Use a search term to find a simple design, such as circle, design, or spiral. 

 

4. Click Search and find an image you like. Click on it and choose Insert. 

 

5. Click Tile picture as texture. 

 

 
 

7. To start all over with a new image, click Reset Background. 

Explore the options to 

create a one of a kind 

design as a 

background to your 

video. 

Optional challenges provide 
enrichment activities. SAMPLE




